PROTOCOL:

1. Preparation of Culture Medium and Culturing of TK6 cells
0. Prepare 565 mL of 1x RPMI culture medium. Add 5 mL of MEM non-essential amino acids (100x), 5 mL of sodium pyruvate (100 mM), 5 mL of penicillin-streptomycin-glutamine (100x), and 50 mL of fetal bovine serum (FBS) to a 500 mL bottle of RPMI 1640 1x medium. Prepare the medium in a biosafety cabinet and store at 2-8 °C. Heat the medium to 37 °C prior to adding it to the TK6 cells.

0. Thaw 1 mL of TK6 cells (stored at -80°C in DMSO) in 10 mL of medium. Centrifuge the cells at 200 x g for 8 min and aspirate the supernatant. Transfer the cells to 50 mL of media and incubate at 37 °C, 5% CO2. The doubling time of TK6 cells varies from ~12-18 hrs and a few (3 or 4) passages will be required for the cells to reach their maximum proliferation rate (doubling time of about 14-15 hr).   

0. Once the cells have reached their optimal proliferation rate, culture 100 mL of cells to a concentration of ~7-8 x 105 cells/mL. 

1. [bookmark: _Ref526326680]Preparation of clastogens and/or aneugens and Cytochalasin B
1. Prepare appropriate stock concentrations of desired clastogens and aneugens. Stock concentrations must be sufficiently low such that chemicals do not precipitate. For example, for Mitomycin C, dissolve a full 2 mg bottle in 10 mL of sterile water to achieve a final stock concentration of 200 µg/mL. Mitomycin C can be stored at 4°C for three months.

1. On experiment day, prepare dilutions of the desired chemicals that are either 10-fold higher than the desired exposure concentrations if diluting in sterile water or 100-fold higher than the desired exposure concentrations if diluting in DMSO. For example, with Mitomycin C, prepare 3 mL dilutions in sterile water of 0.5, 1.0, 2.0, 3.0, 4.0 and 5.0 µg/mL. 

1. Prepare a 200 µg/mL stock concentration of Cytochalasin B by dissolving a 5 mg bottle into 25 mL of DMSO. Cytochalasin B can be stored at -20°C for several months.

2. Note: Cytochalasin B is highly toxic. Inhaling, swallowing or having Cytochalasin B contact skin can be fatal. Wear appropriate personal protective equipment including a laboratory coat and two pairs of nitrile gloves. Wash hands thoroughly after handling.
 
1. Exposure of cells to clastogens and/or aneugens
2. Add 1 mL of desired clastogen or aneugen to 9 mL of cells at ~7-8x105 cells/mL in a T25 flask. For the control samples, add 1 mL of sterile water. Prepare at least two flasks per dose point to perform the experiment in duplicate. Place the flasks in a 37 °C, 5% CO2 incubator for 3 hr. 

0. Note: if chemicals are diluted in DMSO, add only 100 µL of the desired clastogen or aneugen to each flask and add 100 µL of DMSO to controls. Each flask should contain 9.900 mL of cells.

2. After 3 hr, remove flasks from the incubator and transfer cells to 15 mL polypropylene tubes. Centrifuge at 200 x g for 8 min, aspirate the supernatant and transfer cells to new T25 flasks containing a total of 10 mL of fresh culture medium. Add 150 µL of the stock concentration (200 µg/mL) of Cytochalasin B to each flask to achieve a final concentration of 3 µg/mL. 

2. Return the flasks to the 37 °C, 5% CO2 incubator for a recovery time equal to 1.5-2.0 doubling times as recommended by the OECD guidelines12.

2. Note: In this work the doubling time of the TK6 cells used was 15 hr, so a recovery time of 24 hr (1.6 doubling times) was used. Recovery times of less than 1.5 doubling times will not allow nuclear division to take place in samples exposed to higher doses impacting the number of scorable BN cells. Conversely, recovery times of more than 2.0 will produce a disproportionate number of polynucleated cells in samples exposed to lower doses, skewing the cytotoxicity calculations. 

1. Preparation of buffers for fixation and labeling of DNA content

3. Prepare a 75 mM solution of potassium chloride (KCl) by adding 2.79 g to 500 mL of ultrapure water. Stir the solution for 5 min using a magnetic stirrer to thoroughly dissolve the KCl powder and sterile filter the solution through a 200 µm filter. The 75 mM KCl solution can be stored at 4°C for several months.

3. Prepare a sufficient amount of 4% formalin for the experiment, anticipating that a total of 2.1 mL must be added to each sample. For example, to prepare 10 mL of 4% formalin, add 4 mL of 10% formalin stock to 6 mL of 1x Dulbecco's Phosphate-Buffered Saline solution without Ca2+ or Mg2+ (PBS). This 4% formalin can be stored at room temperature for several weeks.

1. Note: CAUTION. Formalin/formaldehyde is toxic if inhaled or swallowed; is irritating to the eyes, respiratory system, and skin; and may cause sensitization by inhalation or skin contact. There is a risk of serious damage to eyes. It is a potential carcinogen.

3. Prepare 510 mL of wash buffer (2% FBS in 1X PBS) by adding 10 mL of FBS to a 500 mL bottle of 1x PBS.

3. Prepare 10 mL of a 100 µg/mL concentration of Hoechst 33342 by adding 100 µL of the stock concentration (1 mg/mL) to 9,900 µL of 1X PBS. The Hoechst 33342 solution can be stored at 4°C for several months.

1. Sample processing: hypotonic swelling, fixation, cell counting and labeling DNA content

4. At the end of the recovery period, remove all flasks from the incubator and transfer all samples to 15 mL polypropylene tubes. Centrifuge all samples at 200 x g for 8 min.

0. Note: depending on the clastogen or aneugen used, it may be necessary to perform a series of separate experiments to determine a dose range that is appropriate such that the top dose does not exceed a cytotoxicity of 55±5%12.

4. Aspirate the supernatant, resuspend the cells and add 5 mL of 75 mM KCl. Mix gently by inversion three times and incubate at 4°C for 7 min.

4. Add 2 mL of 4% formalin to each sample, mix gently by inversion three times and incubate at 4°C for 10 min. This step acts as a “soft fixation”.

4. Centrifuge all samples at 200 x g for 8 min. Aspirate the supernatant and resuspend in 100 µL of 4% formalin for 20 min. This step acts as a “hard fixation”.

4. Add 5 mL of wash buffer and centrifuge at 200 x g for 8 min. Aspirate the supernatant and resuspend in 100 µL of wash buffer. Transfer all samples to 1.5 mL Eppendorf tubes.

4. Perform a cell count on each sample to determine the number of cells per sample. Samples will be highly concentrated so a 1:100 dilution in 1X PBS (10 µL of sample in 990 µL of PBS) will likely be required to obtain an accurate count. 

5. Note: it is best to perform these cell counts using a hemocytometer. The addition of KCl gives the cytoplasm a translucent appearance making it difficult for automated cell counters to recognize them. Also, the use of Cyt-B increases the size of some cells, making it difficult for automated counters to accurately detect them.

4. If not running the samples on the MIFC immediately, they can be stored at 4°C for several days. When ready to run samples, add 5 µL of 100 µg/mL per 1x106 cells/mL to each sample. Also add 10 µL of 500 µg/mL of RNase per 100 µL of sample for a final concentration of 50 µg/mL. Incubate the samples at 37°C, 5% CO2 for 30 min.

4. Micro-centrifuge all samples at 200 x g for 8 min and carefully use a pipette to remove the supernatant such that approximately 30 μL of sample remains. Use a pipette to resuspend all samples before running on the MIFC ensuring there are no bubbles in the tube. Do not vortex. This ensures that all samples are highly concentrated and will minimize acquisition time.

1. Starting and calibrating the MIFC

5. Ensure the sheath, system calibration reagent, debubbler, cleanser and sterilizer containers (see the Table of Materials) are full and the waste tank is empty.

5. Power up the system and double-click on the MIFC software icon (see the Table of Materials).

5. Click the Startup button and make sure that the “Start all calibrations and tests” checkbox is checked. This will flush the system, load sheath and system calibration reagents, and calibrate the system.

1. Running samples on the MIFC

6. Launch the MIFC data acquisition software (see the Table of Materials).

6. Figure 1 shows the instrument settings. Turn on the 405 nm laser and set the laser power to 10 mW (A). Disable all other lasers (including SSC) and set the BF to channels 1 and 9 (B). Confirm that the magnification slider is set to 60X (C), high-sensitivity mode is selected (D), and that only channels 1, 7 and 9 are showing in the image gallery. 

1. Note: If using a one camera MIFC, set the BF to channel 6 and ensure that only channels 1 and 6 are showing in the image gallery.

6. Click on the Scatterplot icon to create a scatterplot. Select the “All” population and select “Area M01” on the X-axis and “Aspect Ratio M01” on the Y-axis. Click on the Square Region icon and draw a region around the single cells. Name this region “Single Cells”. Right click on the plot and select Regions. Highlight the “Single Cells” region and change the x-coordinates to 100 and 900 and change the y-coordinates to 0.75 and 1. 

2. Note: If using a one camera MIFC, select “Area M06” on the X-axis and “Aspect Ratio M06” on the Y-axis.

6. Click on the Scatterplot icon to create a scatterplot. Select the “Single Cells” population and select “Gradient RMS M01” on the X-axis and “Gradient RMS M07” on the Y-axis. Click on the Square Region icon and draw a region around the majority of the cells. Name this region “Focused Cells”. Right click on the plot and select Regions. Highlight the “Focused Cells” region and change the x-coordinates to 55 and 75 and change the y-coordinates to 9.5 and 15.   

3. Note: If using a one camera MIFC with the BF in channel 6, select “Gradient RMS M06” on the X-axis and “Gradient RMS M01” on the Y-axis.

6. Click on the Histogram icon to create a histogram. Select the “Focused Cells” population and select “Intensity M07” as the feature. Click on the Linear Region icon and draw a region across the main peak in the histogram. Name this region “DNA-positive”. Right click on the plot and select Regions. Highlight the “DNA-positive” region and change the coordinates to 2x105 and 2x106.   

4. Note 1: The range of this region may have to be adjusted depending on the intensity. The idea is to eliminate very dimly stained cells at the low end of the intensity histogram.
4. Note 2: If using a one camera MIFC, then use the Intensity M01 feature. 

6. Set the acquisition parameters (Fig. 1E). Specify the file name and the destination folder, change the number of events to 20,000 and select the “DNA-positive” population. 

6. Click Load and place the control sample into the MIFC (Fig. 1F). Click the Acquire button to collect the data (Fig. 1G). Once the acquisition is complete, click the Return button to return the sample (Fig. 1H). Remove the sample tube from the instrument. Repeat this process for all remaining samples in the experiment. 

1. Opening a data file in IDEAS

7. Launch the IDEAS software package (see the Table of Materials).

7. Click on Start Analysis to start the Open File Wizard. Select a data file by browsing to the desired raw image file (.rif). Click the Open button and click Next.

7. Since this is a single color assay, compensation is not necessary so click Next to bypass the compensation step. At this stage there is no analysis template to apply, so click Next again.

2. Note: If using the analysis template downloaded from the supplementary material, select it now. These templates only work with a 2 camera MIFC and the BF must have been set to channels 1 and 9 during acquisition.

7. Name the compensated image file (.cif) and the data analysis file (.daf). By default, the .cif and .daf file names are automatically generated to match the .rif. It is not recommended to change the names of the .cif and .daf. Click Next. Set the image display properties by selecting the “01” and “07” (or “01” and “06” if using a one camera MIFC). Click Next. There is no wizard that can be used for this application, so click Finish.

Note: sections 9 – 12 are very long and only selected key steps are shown in the main text of this paper. The full step-by-step analysis to create all masks, features, dot plots, histograms, custom image views and statistics reports can be found in Supplement 1 – Full Protocol.

Note: it is very important to save the data analysis file (.daf) and the analysis template (.ast) often during this protocol to avoid loss of progress.

1. Creating masks and features to identify BNCs

8. Start by clicking on the Image Gallery Properties icon (blue/white sun icon under the File tab). Under the “Display Properties” click “Set Range to Pixel Data” then change the color to yellow. Click OK. This makes the Hoechst images easier to view since the purple color is difficult to see against the black background.

8. To identify non-apoptotic cells create an “Area-Threshold” feature plot it against the “BF contrast” feature:

1. Click on the Analysis tab, then click Masks. Click New then click Function. Under Function choose “Threshold”, under Mask choose “M07” and set the “Intensity Percentage” to 50. Click OK then OK again. Click Close.

1. Click on the Analysis tab, click Features then click New. For the Feature Type select “Area”. For Mask select the “Threshold(M07,Ch07,50)”. Click Set Default Name and click OK. Click on Close and IDEAS will start calculating the feature values.

1. Click on the Dot Plot icon. Select the “All” population. For the X-axis feature choose the “Contrast_M01_Ch01” feature and for the Y-axis feature choose the “Area_Threshold(M07,Ch07,50). Click OK. 

1. Click the Square Region button and draw a region around the majority of the cells. Call this region “Non-apoptotic”. Right click on the plot and click Regions. Highlight the “Non-apoptotic” region. Set the x-coordinates to 0 and 15 and set the y-coordinates to 50 and 300. Click Close.

8. Create the BNC mask (steps 9.3.1 - 9.3.5) to identify cells that contain only two nuclei.

2. [bookmark: _Ref524085225]Browse for a BNC in the image gallery and click on it. This is to visualize creation of the mask in the Hoechst channel. Click on the Analysis tab, then click Masks. Click New then click Function.

2. Under Function choose “LevelSet”, under Mask choose “M07”, select the “Middle Level Mask” radio button and set the Contour Detail Scale to 3.00. Click OK then OK again. The mask is added to the list on the left.

2. Click New then click Function. Under Function choose “Dilate”, under Mask choose “LevelSet(M07,Ch07,Middle,3)”. Set the image to display to “Ch07”, and set the “Number of Pixels” to 2. Click OK then OK again.

2. Click New then click Function. Under Function choose “Watershed”, under Mask choose “Dilate(LevelSet(M07,Ch07,Middle,3)2)”. Set the image to display to “Ch07”, and set the “Line Thickness” to 1. Click OK then OK again.

2. [bookmark: _Ref524092762]Click New then click Function. Under Function choose “Range”, under Mask choose “Watershed(Dilate(LevelSet(M07,Ch07,Middle,3)2))”. Set the image to display to “Ch07”. Set the minimum and maximum area values to 115 and 5000 respectively. Set the minimum and maximum aspect ratio values to 0.4 and 1 respectively. Click OK. In the Name field change the text to read “BNC” then click OK. The BNC mask is complete.

8. Create the features and plots to obtain the final BNC population

3. Spot Count BNC feature: Click on the Analysis tab, then Features, then New. For the Feature Type select “Spot Count”. For Mask, select the final BNC mask created in 9.3.5. Set the Connectedness to “Four” and change the name to “Spot Count BNC”. Click OK then Close to calculate the feature values. 

3. [bookmark: _Ref524097672]Spot Count BNC histogram. Click the Histogram icon. Select the “Non-apoptotic” population. For the X-axis feature choose the “Spot Count BNC” feature. Click OK. Click on the Linear Region icon. Draw a region across bin “2” on the histogram created in 9.4.2. Call this region “2N”

3. [bookmark: _Ref526327237]BNC Component Masks: 

2. [bookmark: _Ref524099326]BNC Component Mask 1: Click on the Analysis tab, then Masks, then New, then Function. Under Function select “Component”, under Mask select the “BNC” mask. For Ranking Feature select “Area”, for Sorting Order click the “Descending” radio button. Set Rank to “1”. Click OK.

2. BNC Component Mask 2: Repeat all steps in 9.4.3.1 except set Rank to “2”. Click Close.

3. Aspect Ratio Intensity Features: Click on the Analysis tab, then Features, then Add Multiple Features. In the new window under Select Base Features check the “Aspect Ratio Intensity” box, under Select Masks choose both the “Component(1,Area,BNC,Descending)” and “Component(2,Area,BNC,Descending)” masks and under Select Image choose “Ch07”. Click Add Features. In the new window click OK. Click Close, then Close again to start calculating the feature values.

3. Circular Nuclei plot. Click the Dot Plot icon. Select the “2N” population. 
For the X-axis feature choose the “Aspect Ratio Intensity_Component(1, Area, BNC, Descending)” feature. Change the X-axis title to “Aspect Ratio Intensity Component 1 (BNC)”. For the Y-axis feature choose the
“Aspect Ratio Intensity_Component(2, Area, BNC, Descending)” feature. Change the Y-axis title to “Aspect Ratio Intensity Component 2 (BNC)” Click OK. Click the Square Region button and draw a region around the majority of the cells. Call this region “Circular Nuclei”. Right click on the plot and click Regions. Highlight the “Circular Nuclei” region. Set the x-coordinates to 0.75 and 1 and set the y-coordinates to 0.75 and 1. Click Close.

3. Component Area Ratio Feature: Click on the Analysis tab, then Features, then Add Multiple Features. In the new window under Select Base Features check the “Area” box, under Select Masks choose both the “Component(1,Area,BNC,Descending)” and “Component(2,Area,BNC,Descending)” masks and under Select Image choose “Ch07”. Click Add Features. In the new window click OK. Click Close, then Close again to start calculating the feature values. When the calculations are complete, click on the Analysis tab, then Features, then New. Under Feature Type select the “Combined” radio button. In the Features box choose the “Area_Component(2, Area, BNC mask, Descending) feature and click on the down arrow to insert it. Click on the “/” button to insert the division operator. In the Features box choose the “Area_Component(1, Area, BNC mask, Descending)” feature and click on the down arrow to insert it. Under Name, type “Component Area Ratio (BNC)”. Click OK. Click Close.

3. Component Intensity Feature: Click on the Analysis tab, then Features, then Add Multiple Features. In the new window under Select Base Features check both the “Spot Intensity Min” and “Spot Intensity Max” boxes, under Select Masks choose the “BNC” mask and under Select Image choose “Ch07”. Click Add Features. In the new window click OK. Click Close, then Close again to start calculating the feature values. When the calculations are complete, click on the Analysis tab, then Features, then New. Under Feature Type select the “Combined” radio button. In the Features box choose the “Spot Intensity Min_Ch07” feature and click on the down arrow to insert it. Click on the “/” button to insert the division operator. In the Features box choose the “Spot Intensity Max_Ch07” feature and click on the down arrow to insert it. Under Name, type “Component Intensity Ratio (BNC)”. Click OK. Click Close.

3. Similar Area/Intensity plot. Click the Dot Plot icon. Select the “Circular Nuclei” population. For the X-axis feature choose the “Component Intensity Ratio (BNC)” feature. For the Y-axis feature choose the “Component Area Ratio (BNC)” feature. Click OK. Click the Square Region button and draw a region around the majority of the cells. Call this region “Similar Area/Intensity”. Right click on the plot and click Regions. Highlight the “Similar Area/Intensity” region. Set the x-coordinates to 0.75 and 1 and set the y-coordinates to 0.75 and 1. Click Close.

3. Aspect Ratio and Shape Ratio Features: Click on the Analysis tab, then Features, then Add Multiple Features. In the new window under Select Base Features check both the “Aspect Ratio” and “Shape Ratio” boxes, under Select Masks choose the “BNC” mask and under Select Image choose “Ch07”. Click Add Features. In the new window click OK. Click Close, then Close again to start calculating the feature values.

3. Separated Nuclei. Click the Dot Plot icon. Select the “Similar Area/Intensity” population. For the X-axis feature choose the “Shape Ratio (BNC)” feature. For the Y-axis feature choose the “Aspect Ratio (BNC)” feature. Click OK. Click the Square Region button and draw a region around the majority of the cells. Call this region “Separated Nuclei”. Right click on the plot and click Regions. Highlight the “Separated Nuclei” region. Set the x-coordinates to 0.2 and 0.6 and set the y-coordinates to 0.3 and 0.55. Click Close.

3. Average BNC Circularity Feature: Click on the Analysis tab, then Features, then Add Multiple Features. In the new window under Select Base Features check the “Circularity” box, under Select Masks choose both the “Component(1,Area,BNC,Descending)” and “Component(2,Area,BNC,Descending)” masks and under Select Image choose “Ch07”. Click Add Features and in the new window click OK. Click Close, then Close again to start calculating the feature values. Click on the Analysis tab, then Features, then New. Click the “Combined” radio button. Click the “(“ button to insert an open parentheses. From the Features list, highlight “Circularity_Component(1, Area, BNC, Descending)” and click on the down arrow to insert it. Click the “+” symbol. From the Features list, highlight “Circularity_Component(2, Area, BNC, Descending)” and click on the down arrow to insert it. Click the “)” button to insert a closed parentheses. Click on the “/” button to insert the division operator. Beside the down arrow that does not have a drop down list, type the number “2”. Press the down arrow beside the “2” to insert it into the formula. Under Name, type “Circularity BNC Avg”. Click OK. Click Close.

3. Area BNC/Area M07 Ratio Feature: Click on the Analysis tab then Features, then New. Under Feature Type select “Area”. Under Mask select “BNC”. Click Set Default Name and click OK. Click New then click the “Combined” ratio button. Highlight the “Area_BNC” feature and click the down arrow to insert it. Click the “/” button to insert the division symbol. Highlight the “Area_M07” and click the down arrow to insert it. Click Set Default Name and click OK. Click Close again to start calculating the feature values.

3. [bookmark: _Ref524351478]BNCs plot. Click the Dot Plot icon. Select the “Separated Nuclei” population. For the X-axis feature choose the “Circularity BNC Avg” feature. For the Y-axis feature choose the “Area_BNC/Area_M07” feature. Click OK. Click the Square Region button and draw a region around the majority of the cells. Call this region “BNCs”. Right click on the plot and click Regions. Highlight the “BNCs” region. Set the x-coordinates to 7 and 45 and set the y-coordinates to 0.6 and 1. Click Close.

1. Creating masks and features to identify MN within the BNC population

9. Create the MN mask (steps 10.1.1 – 10.1.4.1).

0. [bookmark: _Ref524355508]Browse for a BNC that contains an MN in the image gallery and click on it. This is to visualize creation of the MN mask in the Hoechst channel. Click on the Analysis tab, then click Masks. 

0. Create Spot Identification Mask 1:

1. Click New then click Function. Under Function choose “Spot” and ensure the “Bright” radio button is selected. Under Mask choose “M07”, set the Spot to Cell Background Ratio to “2.00”. Set the Minimum Radius to “2” and the Maximum Radius to “6”. Click OK then OK again. The mask is added to the list on the left.

1. Click New then click Function. Under Function choose “Range”, under Mask choose “LevelSet(M07,Ch07,Middle,3)”. Set the Image to display to “Ch07”. Set the Minimum Area to 80 and the Maximum Area to 5000. Set the Minimum Aspect Ratio to 0 and the Maximum Aspect Ratio to 1. Click OK then OK again.

1. Click New then click Function. Under Function choose “Dilate”, under Mask choose “Range(LevelSet(M07,Ch07,Middle,3),80-5000,0-1)”. Set the Image to display to “Ch07”. Set the Number of Pixels to “2”. Click OK then OK again.

1. [bookmark: _Ref524354204]Click New. Double Click on the “Spot(M07, Ch07, Bright, 2, 6, 2)” mask to add it to the mask definition. Click the “And” Boolean operator button and then the “Not” Boolean operator button. Double click the “Dilate(Range(LevelSet(M07, Ch07, Middle, 3), 80-5000, 0-1), 2)” mask to add it to the mask definition. Click OK.

1. Click New, then Function. Under Function choose “Range” and under mask choose the mask created in 10.1.2.4:
“Spot(M07, Ch07, Bright, 2, 6, 2)” And Not “Dilate(Range(LevelSet(M07, Ch07, Middle, 3), 80-5000, 0-1), 2)”.
Set the Image to Display to “Ch07”. Set the Minimum Area to 10 and the Maximum Area to 80. Set the Minimum Aspect Ratio to 0.4 and the Maximum Aspect Ratio to 1. Click OK then OK again. Spot identification mask 1 is complete.

0. Create Spot Identification Mask 2:

2. Click New then click Function. Under Function choose “Spot” and ensure the “Bright” radio button is selected. Under Mask choose “M07”, set the Spot to Cell Background Ratio to “2.00”. Set the Minimum Radius to “1” and the Maximum Radius to “6”. Click OK then OK again.

2. Click New then click Function. Under Function choose “Morphology”, under Mask choose “M07”. Click OK then OK again.

2. Click New then click Function. Under Function choose “Dilate”, under Mask choose “Morphology(M07, Ch07)”. Set the Image to display to “Ch07”. Set the Number of Pixels to “3”. Click OK then OK again.

2. [bookmark: _Ref524355021]Click New. Double Click on the “Spot(M07, Ch07, Bright, 2, 6, 1)” mask to add it to the mask definition. Click the “And” Boolean operator button and then the “Not” Boolean operator button. Double click the “Dilate(Morphology(M07, Ch07), 3)” mask to add it to the mask definition. Click OK.

2. Click New, then Function. Under Function choose “Range” and under mask choose the mask created in 10.1.3.4:
“Spot(M07, Ch07, Bright, 2, 6, 1)” And Not “Dilate(Morphology(M07, Ch07), 3”.
Set the Image to Display to “Ch07”. Set the Minimum Area to 8 and the Maximum Area to 80. Set the Minimum Aspect Ratio to 0.4 and the Maximum Aspect Ratio to 1. Click OK then OK again. Spot identification mask 2 is complete.

0. Create the final MN mask:

3. [bookmark: _Ref524355519]Click New. Double click on spot identification mask 1:
“Range(Spot(M07, Ch07, Bright, 2, 6, 2) And Not Dilate(Range(LevelSet(M07, Ch07, Middle, 3), 80-5000, 0-1), 2), 10-80, 0.4-1)” to add it to the mask definition.
Click the “OR” Boolean operator button. Double click on spot identification mask 2:
“Range(Spot(M07, Ch07, Bright, 2, 6, 1) And Not Dilate(Morphology(M07, Ch07), 3), 8-80, 0.4-1)” to add it to the mask definition. Change the Name to “MN Mask” and click OK. The MN mask is complete.

0. Create individual MN component masks:

4. [bookmark: _Ref524356419]MN Component mask 1: In the Mask Manager window click New then Function. Under Function select “Component”, under Mask select the “MN mask”. For Ranking Feature select “Area”, for Sorting Order click the “Descending” radio button. Set Rank to “1”. Click OK.

4. [bookmark: _Ref526485776]MN Component Masks 2-4: Repeat all steps in 10.1.5.1 except set Rank to “2” then “3” then “4”. This gives a total of four independent component MN masks:
“Component(1, Area, MN Mask, Descending)”
“Component(2, Area, MN Mask, Descending)”
“Component(3, Area, MN Mask, Descending)”

0. Create the MN Components Mask:

5. [bookmark: _Ref526485815]In the Mask Manager window click New. Double click on the “Component(1, Area, MN Mask, Descending)” mask to add it to the mask definition. Click on the “Or” Boolean operator button.  
Double click on the “Component(2, Area, MN Mask, Descending)” mask to add it to the mask definition. Click on the “Or” Boolean operator button.
Double click on the “Component(3, Area, MN Mask, Descending)” mask to add it to the mask definition. Click on the “Or” Boolean operator button. Click OK. Click Close.

[bookmark: _GoBack]Note: it is extremely rare to encounter BNCs with more than 3 MN. However, additional component masks can be created by following the steps in 10.1.5.1 and 10.1.5.2. These masks can then be added to the “MN Components” mask by following 10.1.6.1.

0. Create the Skeleton mask to remove false positive artifacts between the nuclei:

6. Click on the Analysis tab then click Masks. Click New then click Function. Under Function choose the “Dilate” mask. Under Mask choose the “BNC m” mask. Set the Number of Pixels to “4” and click OK and OK again.

6. Click New then Function. Under Function choose the “Skeleton” mask. Uncheck the “Link inputs” checkbox. Make sure the “Thin” radio button is checked. Under Mask choose the “Dilate(BNC, 4)” mask. Under Image to Display choose “Ch07” and under Channel choose “Ch07”. Click OK and OK again.

6. Click New then Function. Under Function choose the “Dilate” mask. Uncheck the “Link inputs” checkbox. Under Mask choose the “Skeleton(Dilate(BNC, 4), Ch07, Thin)” mask. Under Image to Display choose “Ch07” and under Channel choose “Ch07”. Set the Number of Pixels to “1”. Click OK and OK again.

6. Click New. Double click on the “Dilate(Skeleton(Dilate(BNC, 4), Ch07, Thin), 1)” mask to add it to the mask definition. Click on the “Or” Boolean operator button. Double click on the “MN Components” mask to add it to the mask definition. Click OK. Click Close.

0. Create the Cytoplasm mask to ensure MN being identified are inside the cell:

7. Click on the Analysis tab then click Masks. Click New then click Function. Under Function choose “Adaptive Erode”. Set the Adaptive Erode Coefficient to “85”. Click OK and OK again.

7. Click New then Function. Under Function choose the “Dilate” mask. Uncheck the “Link inputs” checkbox. Under Mask choose the “AdaptiveErode (M01,Ch01,85)” mask. Under Image to Display choose “Ch01” and under Channel choose “Ch01”. Set the Number of Pixels to “4”. Click OK and OK again.

7. Click New. Double click on the “Dilate(AdaptiveErode(M01,Ch01,85),4)” mask to add it to the mask definition. Click on the “Or” Boolean operator button. Double click on the “MN Components” mask to add it to the mask definition. Click OK. Click Close.

9. Create the features, dot plots and histograms to identify the BNCs containing MN

1. MN Spot Count feature. Click on Analysis, then Features, then New. Under Feature Type ensure the “Single” radio button is selected and choose “Spot Count” from the dropdown list. Under Mask choose “MN mask” and set the Connectedness to “Eight”. Click Set Default Name then click OK, then Close to begin calculating the feature values.  

1. MN Spot Count Histogram. Click the Histogram icon to create a histogram. Select the “BNCs” population as the parent population and select “Spot Count_MN Mask_8” as the feature. Click OK to add the histogram to the analysis area. Click on the Linear Region icon and draw a region from about 0.5 to 4.5. Name this region “all MN”. Right click on the plot and select Regions. Highlight the “all MN” region and change the X coordinates to 0.5 and 4.5. Click Close.   

1. [bookmark: _Ref526160838]Create Features and Dot Plot to ensure MN are inside the cytoplasm.

2. [bookmark: _Ref526159271]MN Inside Cytoplasm Feature. Click Analysis, then Features, then New. Ensure the “Single” radio button is selected and choose “Spot Distance Min” from the dropdown list. Under Mask choose “Dilate(AdaptiveErode(M01, Ch01, 85), 4) Or MN Components“ and click Set Default Name and then click OK.

2. [bookmark: _Ref526159273]MN between nuclei Feature. In the still open Feature Manager window, click New. Ensure the “Single” radio button is selected and choose “Spot Distance Min” from the dropdown list. Under Mask choose “Dilate(Skeleton(Dilate(BNC, 4), Ch07, Thin, 1) Or MN Components“ and click Set Default Name and then click OK. Click Close to calculate the features in steps 10.2.3.1 and 10.2.3.2.

2. Dot Plot. Click the Dot Plot icon. Select “all MN” as the parent population. For the X Axis Feature choose “Spot Distance Min_Dilate(Skeleton(Dilate(BNC, 4), Ch07, Thin, 1) Or MN Components” and for the Y Axis Feature choose “Spot Distance Min_Dilate(AdaptiveErode(M01, Ch01, 85), 4) Or MN Components“. Click the Square Region button and draw a region around the majority of the cells. Name this region “MN Inside Cytoplasm”. Right click on the plot and click Regions. Highlight the “MN Inside Cytoplasm” region. Change the X Coordinates to 0.1 and 20 and change the Y Coordinates to -0.5 and 0.5. Click Close.

1. [bookmark: _Ref526160360]Create Features and Dot Plot to identify the final MN population.

3. Aspect Ratio MN Feature. Click the Analysis tab then Features then New. Ensure the “single” radio button is selected and under Feature Type choose “Aspect Ratio”. Under Mask select the “MN mask”. Click Set Default Name and click OK. 

3. Median Pixel BNC/Median Pixel MN combined feature. 

1. With the Feature Manager window still open click New then select “Median Pixel” as the Feature Type. Under Mask select “BNC” and under Image select “Ch07”. Click Set Default Name and click OK.

1. With the Feature Manager window still open click New then select “Median Pixel” as the Feature Type. Under Mask select “MN_Mask” and under Image select “Ch07”. Click Set Default Name and click OK.

1. With the Feature Manager window still open click New then select the “combined” radio button under Feature Type. Select the “Median Pixel_BNC_Ch07” and click the down arrow to add it to the mask description. Click the division icon (/) to add the division symbol to the feature. Next, select the “Median Pixel_MN Mask_Ch07” and click the down arrow to add it to the mask description. Click Set Default Name and click OK. to calculate all features created in all steps in 10.2.4.

3. Dot Plot. Click the Dot Plot icon. Select “MN Inside Cytoplasm” as the parent population. For the X Axis Feature choose “Median Pixel_BNC_Ch07/Median Pixel_MN Mask_Ch07” and for the Y Axis Feature choose “Aspect Ratio_MN Mask“. Click the Square Region button and draw a region around the majority of the cells. Name this region “MN BNCs”. Right click on the plot and click Regions. Highlight the “MN BNCs” region. Change the X Coordinates to 1 and 5 and change the Y Coordinates to 0.6 and 1.0. Click Close.

1. Create masks, features and plots to identify the Mononucleated and Polynucleated populations

10. Create the POLY mask. Click Analysis, then Masks, then New then Function. Under Function choose “Range”, under Mask choose “Watershed(Dilate(LevelSet(M07, Ch07, Middle, 3), 2))”. Set the image to display to “Ch07”. Set the minimum and maximum area values to 135 and 5000 respectively. Set the minimum and maximum aspect ratio values to 0.4 and 1 respectively. Click OK. In the Name field change the text to read “POLY” then click OK then Close. The Polynucleated cell mask is complete.

10. Create the POLY Component Masks

1. [bookmark: _Ref526163629]POLY Component Mask 1: Click on the Analysis tab, then Masks, then New, then Function. Under Function select “Component”, under Mask select the “POLY” mask. For Ranking Feature select “Area”, for Sorting Order click the “Descending” radio button. Set Rank to “1”. Click OK then OK again.

1. POLY Component Mask 2: Repeat all steps in 11.2.1 except set Rank to “2”. Click Click OK then OK again.

1. POLY Component Mask 3: Repeat all steps in 11.2.1 except set Rank to “3”. Click Click OK then OK again.

1. POLY Component Mask 4: Repeat all steps in 11.2.1 except set Rank to “4”. Click Click OK then OK again. Click Close to close the mask manager.

10. Spot Count using POLY mask

2. Click the Analysis tab, then Features, then New. For Feature Type, select “Spot Count”. For Mask choose the “POLY” mask and set the Connectedness at “4”. Click Set Default Name and click OK then Close to calculate the feature values. 

2. [bookmark: _Ref526164604]Click the Histogram icon. Select the “Non-apoptotic” population. For the X-axis feature choose the “Spot Count_POLY_4” feature. 

2. MONO spot count region. Click on the Linear Region icon. Draw a region across bin “1” on the histogram created in 11.3.2. Call this region “1N”

2. TRI spot count region. Click on the Linear Region icon. Draw a region across bin “3” on the histogram created in 11.3.2. Call this region “3N”

2. QUAD MONO spot count region. Click on the Linear Region icon. Draw a region across bin “4” on the histogram created in 11.3.2. Call this region “4N”

10. Identify the MONO population

3. Create the MONO Aspect Ratio Feature. Click the Analysis tab, then Features, then New. Under Feature Type, select the “Aspect Ratio” feature and under Mask select “Component(1, Area, POLY, Descending)”. Click Set Default Name then click OK. 

3. Create the MONO Circularity Feature. With the Feature Manager window still open, click New. Under Feature Type, select the “Circularity” feature and under Mask select “Component(1, Area, POLY, Descending)”. Click Set Default Name then click OK then click Close to calculate the feature values. 

3. Circular MONO cells dot plot. Click the Dot Plot icon. Select “1N” as the parent population. For the X Axis Feature choose “Circularity_Component(1, Area, POLY, Descending)” and for the Y Axis Feature choose “Aspect Ratio_Component(1, Area, POLY, Descending)“. Click OK. Click the Square Region button and draw a region around the cell population towards the top right portion of the plot. Name this region “Circular_1N”. Right click on the plot and click Regions. Highlight the “Circular_1N” region. Change the X Coordinates to 20 and 55 and change the Y Coordinates to 0.85 and 1.0. Click Close.

3. Create the Area POLY/Area_M07 feature. Click the Analysis tab, then Features, then New. Under Feature Type, select the “Area” feature and under Mask select “Component(1, Area, POLY, Descending)”. Click Set Default Name then click OK. Click
With the Feature Manager window still open, click New then under Feature Type click the “Combined” radio button. From the list of features, highlight the “Area_Component(1, Area, POLY, Descending)” and click the down arrow to add it to the feature definition. Click the division symbol (/). Select the Area_M07 feature and click the down arrow to add it to the feature definition. Click Set Default Name and click OK. Click Close to start calculating the feature values.

3. Final MONO population dot plot. Click the dot plot icon. Select “Circular_1N” as the parent population. For the X Axis Feature choose “Aspect Ratio_M07” and for the Y Axis Feature choose “Area_Component(1, Area, POLY, Descending) / Area_M07“. Click OK. Click the Square Region button and draw a region around the majority of the cells. Name this region “Mononucleated”. Right click on the plot and click Regions. Highlight the “Mononucleated” region. Change the X Coordinates to 0.85 and 1.0 and change the Y Coordinates to 0.55 and 1.0. Click Close.

10. Identify the trinucleated and quadranucleated cells

4. Create the Component Aspect Ratio and Circularity Features. Click the Analysis tab, then Features, then Add Multiple Features. Under Select Base Features, select the check boxes next to “Aspect Ratio” and “Circularity”. Under Selected Masks select:
“Component(2, Area, POLY, Descending)”
“Component(3, Area, POLY, Descending)”
“Component(4, Area, POLY, Descending)”

Under Select Image choose “Ch07”. Click Add Features, then click OK. Verify that the following six features will be created:
“Aspect Ratio_Component(2, Area, POLY, Descending)”
“Aspect Ratio_Component(3, Area, POLY, Descending)”
“Aspect Ratio_Component(4, Area, POLY, Descending)”
“Circularity_Component(2, Area, POLY, Descending)”
“Circularity_Component(3, Area, POLY, Descending)”
“Circularity_Component(4, Area, POLY, Descending)”
Click Close to calculate the feature values.

4. Create the Average TRI Aspect Ratio Feature. Click the Analysis tab then Features, then New. Under Feature Type, click the “Combined” radio button. Click the open parenthesis button “(“ to add it to the feature definition.
Select the “Aspect Ratio_Component(1, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Aspect Ratio_Component(2, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Aspect Ratio_Component(3, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the close parenthesis “)” button to add it to the feature definition.
Click the division symbol “/” to add it to the feature definition. Type the number “3” into the box beside the arrow and click the arrow to insert it into the feature definition. 
Under Name type “Aspect Ratio Trinucleated (Average)” and click OK.

4. Create the Average TRI Circularity Feature. Click the Analysis tab then Features, then New. Under Feature Type, click the “Combined” radio button. Click the open parenthesis button “(“ to add it to the feature definition.
Select the “Circularity_Component(1, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Circularity_Component(2, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Circularity_Component(3, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the close parenthesis “)” button to add it to the feature definition.
Click the division symbol “/” to add it to the feature definition. Type the number “3” into the box beside the arrow and click the arrow to insert it into the feature definition. 
Under Name type “Circularity Trinucleated (Average)” and click OK then click Close.

4. Trinucleated Cell dot plot. Click the dot plot icon. Select “3N” as the parent population. For the X Axis Feature choose “Circularity Trinucleated (Average)” and for the Y Axis Feature choose “Aspect Ratio Trinucleated (Average)”. Click OK. Click the Square Region button and draw a region around cells near the top right of the plot. Name this region “Trinucleated”. Right click on the plot and click Regions. Highlight the “Trinucleated” region. Change the X Coordinates to 13 and 35 and change the Y Coordinates to 0.85 and 1.0. Click Close. 

4. Create the Average QUAD Aspect Ratio Feature. Click the Analysis tab then Features, then New. Under Feature Type, click the “Combined” radio button. Click the open parenthesis button “(“ to add it to the feature definition.
Select the “Aspect Ratio_Component(1, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Aspect Ratio_Component(2, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Aspect Ratio_Component(3, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Aspect Ratio_Component(4, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the close parenthesis “)” button to add it to the feature definition.
Click the division symbol “/” to add it to the feature definition. Type the number “4” into the box beside the arrow and click the arrow to insert it into the feature definition. 
Under Name type “Aspect Ratio Quadranucleated (Average)” and click OK.

4. Create the Average QUAD Circularity Feature. Click the Analysis tab then Features, then New. Under Feature Type, click the “Combined” radio button. Click the open parenthesis button “(“ to add it to the feature definition.
Select the “Circularity_Component(1, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Circularity_Component(2, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Circularity_Component(3, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the plus (+) button to add it to the feature definition.
Select the “Circularity_Component(4, Area, POLY, Descending)” feature and click the down arrow to add it to the feature definition. Click the close parenthesis “)” button to add it to the feature definition.
Click the division symbol “/” to add it to the feature definition. Type the number “4” into the box beside the arrow and click the arrow to insert it into the feature definition. Under Name type “Circularity Quadranucleated (Average)” and click OK then click Close.

4. Quadranucleated Cell dot plot. Click the dot plot icon. Select “4N” as the parent population. For the X Axis Feature choose “Circularity Quadranucleated (Average)” and for the Y Axis Feature choose “Aspect Ratio Quadranucleated (Average)”. Click OK. Click the Square Region button and draw a region around cells near the top right of the plot. Name this region “Quadranucleated”. Right click on the plot and click Regions. Highlight the “Trinucleated” region. Change the X Coordinates to 13 and 35 and change the Y Coordinates to 0.85 and 1.0. Click Close. 

1. Create a custom view to examine the BNC and MN masks

11. Click on the Image Gallery Properties button (Blue and White icon) then click on the View tab. Click on the Composites tab then click New. Under Name type “Ch01/Ch07”. Click Add Image. Under Image choose “Ch01” and set the Percent to 100. Click Add Image again, under Image choose “Ch07” and set the Percent to 100.

11. Click New and under Name type “BNC and MN masks”

11. Click Add Column. Under Image Type choose “Ch01” and under Mask choose “None”

11. Click Add Column. Under Image Type choose “Ch07” and under Mask choose “None”

11. Click Add Column. Under Image Type choose “Ch07” and under Mask choose “BNC”

11. Click Add Column. Under Image Type choose “Ch07” and under Mask choose “MN mask”

11. Click Add Column. Under Image Type click the “Composite” radio button. The “Ch01/Ch07” composite image should be automatically added to the view. Click OK to close the Image Gallery Properties window.

11. To display the custom view, click the View pulldown menu and select “BNC and MN masks”. Click the Show/Hide Masks button to display the BNC and MN masks on top of the Ch07 images.

1. Create a custom view to examine the POLY mask

12. Click on the Image Gallery Properties button (Blue and White icon) then click on the View tab. 

12. Click New and under Name type “POLY mask”

12. Click Add Column. Under Image Type choose “Ch01” and under Mask choose “None”

12. Click Add Column. Under Image Type choose “Ch07” and under Mask choose “None”

12. Click Add Column. Under Image Type choose “Ch07” and under Mask choose “POLY”

12. Click Add Column. Under Image Type click the “Composite” radio button. The “Ch01/Ch07” composite image should be automatically added to the view. Click OK to close the Image Gallery Properties window.

12. To display the custom view, click the View pulldown menu and select “POLY mask”. Click the Show/Hide Masks button to display the BNC and MN masks on top of the Ch07 images.

1. Create a statistics table to enumerate key events

13. Click on the Reports tab then click “Define Statistics Report”. In the new window, click Add Columns.

13. Add the BNC count statistic. Under Statistics select “Count” and under Selected Population choose the “BNCs” population. Click “Add Statistics” to add the statistic to the list.

13. Add the MN count statistic. Under Statistics select “Count” and under Selected Population choose the “MN BNCs” population. Click “Add Statistics” to add the statistic to the list.

13. Add the MONO count statistic. Under Statistics select “Count” and under Selected Population choose the “Mononucleated” population. Click “Add Statistics” to add the statistic to the list.

13. Add the TRI count statistic. Under Statistics select “Count” and under Selected Population choose the “Trinucleated” population. Click “Add Statistics” to add the statistic to the list.

13. Add the QUAD count statistic. Under Statistics select “Count” and under Selected Population choose the “Quadranucleated” population. Click “Add Statistics” to add the statistic to the list. Click Close then click OK.

13. Note: to change how the columns are labeled in the statistics table, highlight each row in the table and uncheck the “Use default title” option. Then in the Column title field, type the desired column title.

13. Ensure that the statistics table is providing the correct values. Click the Reports tab then click “View Statistics Report”. 

13. [bookmark: _Ref526249967]The data analysis template is complete. Save your template (File, Save as Template).

1. Batch process experiment files using the data analysis template

14. Open a new instance of the IDEAS software package. Under the Tools menu click “Batch Data Files” then click “Add Batch” in the new window.

14. In the new window click “Add Files” to select the experiment files (.rif) to add to the batch. Under the Select a template or data analysis file (.ast, .daf) option, click the open folder icon to browse to and open the data analysis template (.ast file) that was saved in step 14.9.

14. Click the Preview Statistics Report button to ensure the proper analysis template has been selected

2. Note: No values will be displayed here since they have not yet been calculated. However, this step serves as a check to ensure the proper analysis template has been selected prior to running the batch.

14. Click OK to close the current window. Then click Submit Batches to start the batch processing of all files.

14. [bookmark: _Ref526250726]When the batch processing has completed a .txt file will be available in the folder that contains all of the .rif files. The statistics can then be used to calculate genotoxicity and cytotoxicity.

1. Calculating the genotoxicity and cytotoxicity parameters

15. Calculating genotoxicity

0. To calculate genotoxicity, use the statistics table created in 15.5. Divide the number of cells in the “MN BNCs” population by the number of cells in the “BNC” population then multiply by 100:



15. Calculating cytotoxicity

1. Determine the total number of POLY cells by summing the number of TRI and QUAD cells. 

1. Calculate the Cytokinesis-Block Proliferation Index (CBPI) by using the number of cells in the MONO, BNCs and POLY as follows:



1. Finally, calculate the cytotoxicity of each culture by using the CBPI values from the control cultures (C) and chemically exposed culture (T) as follows:



